7 Introduction to iMovie 5.0

Digital Storytelling was there in December of 1999 when iMovie was announced at Apple Computer. CDS co-founder Dana Atchley and associate Harry Marks hosted the first two iMovie workshops for youth and Apple Masters at Apple’s Cupertino campus.

Since that time, CDS has watched the development of iMovie to the current version 5.0. iMovie has grown to be an increasingly sophisticated tool for telling digital stories, and we are confident that it will become even better. iMovie is also now supported by a number of third party companies that provide excellent enhancements for this tool, making it near-to-competitive with the professional digital video editing toolset.

iMovie - The Video Editor

iMovie was developed as a the first real “plug and play” video editor taking advantage of the Firewire DV capabilities that were being built onto the Apple Computer platforms. The idea was to simply plug a digital video camera to your computer, turn on the camera, open iMovie, and start grabbing and editing video. When you are done, you could record the finished movie back to tape or make a multimedia movie for playing on your computer, a CD ROM or over the web. Before we explore the use of iMovie for telling a digital story using mainly still images and a bit of video, we want to demonstrate the basics of iMovie, in grabbing and editing video clips. If you are doing this tutorial at home, choose a video tape from your library, and connect your camera to computer by Firewire cable. Make sure the camera is in VCR mode and on.

To open iMovie, find the iMovie icon on your desktop in your dock and double-click.

iMovie will ask if you want to return to an existing project, or make a new project. Choose Create Project.

To start with we want to set some preferences for iMovie. Go to the iMovie pull down menu to Preferences.
iMovie can assist you in the process of building your movie in a number of ways. For our demonstration, we want you to make sure the *Start new clip at each scene break* preference is on (as shown). This preference means that as you capture video from your camera, the computer will separate out into individual clips, every time you stopped the camera to shoot a new scene. You can close the preference window.

Now, make sure you set iMovie to capture mode by toggling the blue button to the Camera icon. iMovie will automatically control the camera, so you can play, stop, rewind and fast forward to the appropriate parts of your video tape. In our example, we are grabbing three clips from our video. To record, click on the **Play** button and then the **Import** button. Click the same button again to stop the video capture.

As iMovie sees the edits, it drops the new clips into the Clip Pane. From this pane, you can re-order (good for storyboarding), duplicate (copy/paste), and re-name the clips.

To rename, click on the words at the bottom of the thumbnail image in the clip pane.

Once you are ready to edit, you can switch from Camera-Capturing to Scissors-Editing.

Editing occurs when you drag the clips from the clip pane window to the track along the bottom of the iMovie window. There are two modes of editing, **Clip View** and **Timeline**. **Clip View** presents each edit in a row.

To play the edit, you can click on the play button, and you will see each edit appear and the slider moves across the bottom of the display.

The alternative editing mode is called the Timeline mode. To switch to Timeline mode, click on the icon of a clock as shown. In Timeline mode you can see a representation of the duration of the clips in time going from left to right, a small thumbnail image of the clips contents, and below the clips two audio tracks for editing your voiceover and soundtrack.

At it’s most essential, this is how iMovie works, you capture, you sort, you edit. Many video projects could be produced with only these simple steps. But making a digital story, emphasizing still images and a bit of video, requires us to use all of iMovie’s tools and functions. Now let’s make our tutorial movie, *Momnotmom*. 
NOTE: The numbers in the right margin correspond to each step in the Hands-on Workshop Guide at the end of this Tutorial, covering all the steps outlined on the following pages.

**MOMNOTOMOM - A Digital Story**

In 1999, former CDS community programs director Thenmozhi Soundararajan created *Momnotmom*, a movie about her mom, to be used as the basis of our tutorial. To view the original *Momnotmom*, open the Quicktime movie, *momnotmom.mov*, in your Tutorial folder, or visit: www.storycenter.org/understanding.html

From the Photoshop Elements Tutorial you are familiar with a number of the images that were created for this project.

**Importing Material**

Just as then, you can find the material we will use in this project in your Tutorial folder. For those of you familiar with the iLife features available to iMovie 5, you know it allows you to drag and drop your material into the programs to immediately give you access to these files through iMovie.

Drag a copy of all the images we prepared earlier in Photoshop from your *sizeimag* folder into your iPhoto Library. Similarly you can copy your *voiceover* and *soundtrack* folders into your iTunes Library.

If you don’t have iLife software on your computer, you can also bring the files in by using the **File/Import** menu in iMovie. The files will appear in the Clip Pane, where you can edit as shown above.

Note: Audio files that are imported will go directly to the Timeline, so import them in the order you plan to use them, one at a time.

Create a New Project [**File/New Project...**] and call it “Momnotmom” and save it either in the Movies folder or on the Desktop.
Beginning the Edit

To begin our edit, we want to lay down our voiceover in our Timeline. We’ll start with the voiceover so that we can make our photo edits according to how the story is told.

To find the voiceover we placed in iTunes, click on the Audio button below the Clip Pane. iTunes are available to you based on your various folders, find the soundtrk folder in your pull down menu, as shown.

You can now bring in the three voiceover clips: a_theres, b_search, and c_across, into your Timeline. You can either drag and drop the clips to the Timeline one at a time from the Audio Pane, or you can use the Place at Playhead button to add them in sequence, one at a time. Be sure to move the playhead to the place in the timeline where you want to place the audio, prior to importing. The audio clips will automatically be placed on the lower audio timeline. Since we intend to add a music track, we suggest that you move the audio tracks to the upper audio timeline.

Now we are ready to add our photos to the Timeline, using the voiceover to inform our edits. Go to your iMovie Button bar and click on the Photos button to view the images available to you from iPhoto. To bring the first image into the Timeline, moon720, just click on the image and drag it to the beginning of your Timeline.

As we showed above, click on the play button to listen to the voiceover, notice a playhead moves across the Timeline as you hear the voiceover. We want to stop the playhead and set it at approximately 02:25, or 2 seconds and 25 frames in time. This corresponds to right after the voiceover says the word, mother. In video editing to a narration, we’re trying to find cues for switching from one image, or piece of video, to another. The playhead allows us to see the point in the narrative for the cue.
We now want to reduce the duration of this clip to a precise playing time of 2 seconds and 25 frames. We do this by simply double-clicking on the moon clip in the Timeline, which brings up the Clip Info window. Here we can type 02:25 in the duration box, and click on OK. We can also set the length of the clip in the “Ken Burns effect” in the Photos tab. Click on the image, change the length of the clip (slide the button between the “hare” and the “tortoise”) and then click the Update button.

Now we’re ready to bring in the next image, search, right after moon in the Timeline. How long should search remain visible? As we listen to the voiceover, the narrator tells us about the image of her mother, how curious it is, and how it takes her across oceans and between cultures to back to who she was as a girl. Search will remain on for the entire duration of the narration from the spoken word mother at more or less 3 seconds, to the word girl at 29 seconds. So 26 seconds is our desired length. We double-click on search in the Timeline and set the duration to 26:00 seconds. Click OK.

Each image clip can be set to a specific duration in the Timeline, in association with the voiceover. Or you can set the duration in the Image Window before you drag it in to the Timeline. With next three images, we want them to come in at 3 seconds each to correspond with the words, girl, young woman, and doctor in the narration. You can set the duration to 3:00 seconds using the Slider in the Photos Tools.

After changing the duration for each, you can drag the images, girl, young woman, and doctor into the Timeline. If you bring your playhead back and play through this section of the edit, you can hear the cue words are now in sync with the images.

**Importing Video Files**

The next cue, wife, happens to use our first video clip. We need to import the video into our project, which we can do by going to the File Pull down menu and choosing Import.

You will find a clip called wife.mov inside your Tutorial folder, in the video subfolder. As you import video into iMovie, the software will automatically re-sample the video clip to the appropriate file format for editing in
Chapter 7: Introduction to iMovie

iMovie. This can save you loads of time and trouble if you are using video clips that you already captured, or that you are using from stock video or archival sources.

Once it is imported it appears in your Clip Pane. With video clips, you can double-click on them to have them appear in the Monitor, and review them to decide if you need to trim, or crop, part of the duration of what was captured for your edit.

In our case, we need between two and a half and three seconds of video to work with our edit (the narrator says, a wife then a mother. So we are going to see if there is a good place to edit the clip to that duration. Double-click on the wife.mov clip in the Clip Pane and then play the clip until you see reach around 2 seconds, 20 frames. You will see the smiling face to know this is a happy place for the edit.

We can now crop the video to this duration before we bring it into the Timeline. To do this, pull down the Edit menu to Crop, and voila! You have a new edit.

Now drag the wife.mov video from the Clip Pane to the Timeline after the doctor720 clip.

Your final edit is the mother720 clip, from your photos. Drag it to the Timeline, and your basic edit is done. In many projects, completing the basic edit is a great way to see if all of your images and video work with your narration in terms of the implicit or explicit meaning of the images with the text. You sometimes find certain images might not be on long enough for your audience to study the images and you can choose to reduce a few images. Or perhaps you find that you have only one image or clip to cover too much of the narration, and it gets boring. In this case you may want to add more images. Or you could consider doing some special effects to enhance the images you already have. As you will see below, we believe that search720 needs a bit of spicing up.

Adding Transitions

Before we get to the fancier special effects, we want to take a moment to demonstrate the Transition features in iMovie. Most digital video editors give you many choices in Transitions, and iMovie is no exception. For the most part, the standard Transition is the Cross Dissolve, where one image or video fades into the other.
To access our Transition menu click on the Trans button in the Button bar. We'll start by choosing Cross Dissolve from our menu of Transition choices. We want our Transitions to be short, so let's set the Speed to 00:10, which is 10 Frames (1/3 of a second).

Now you just drag the Cross Dissolve Transition to the Timeline in the space between the first two clips and let go.

As you watch, iMovie quickly renders the Transition, and you can now play the Transition to see the effect of one image blending into another. Go ahead and add Transitions between all of the edits in our little movie.

Remember we mentioned at the moon edit, we added 10 frames to the first edit to give us some space for the Transition. You may have noticed that by the time you added all the Transitions in the story, the duration of your movie shrank. Transitions actually borrow time from both clips, in this case 5 frames, to create the overlap for the movie. Keep this in mind as you are doing a longer edit.

Special Effects - The Ken Burns Effect

In making the average Digital Story for the first time, you end up with a few images that have to do a great amount of narrative work. That is, they are very critical to the story, and/or you only have a few images that really fit the story perfectly. What can you do? Well the professional filmmakers figured out a long time ago that you can bring life to a still image by a number of effects, but perhaps the most common is the pan and/or zoom on an image. In the old days this meant putting the image up on the wall, and having the film camera zoom in and zoom out, or roll across a dolly and pan across the image. Those of you familiar with documentary filmmaker Ken Burns (Civil War, Baseball, Jazz, etc.) know that his films live and die by the pan and zoom. In the digital world, this has been made a great deal easier, and as an homage to Ken and his zooming film technique, Apple coined their version of the effect in his honor.

In our story, we want to create a more dynamic way to look at the search image. The image is up for 26 seconds, and that is just too long to look at a static still image. So what we want to do is put a zoom on the clip using iMovie's Ken Burns Effect.

The Ken Burns effect works on a basic principal. The starting point of a pan and zoom is set, adjusting the zoom magnification and the placement of the image within the
visible frame. You then can set the finish point of the effect. If the two points are different, you get the effect of a zoom in, zoom out, or pan across and image.

There is an issue with iMovie HD and still images: because the aspect ratio is 720 pixels across by 480 pixels down (rather than the older 640x480), if images are imported at 100%, there will be black lines at the top and bottom of the image. Therefore, setting the starting point at 1:15 on the zoom bar will zoom in enough to eliminate these black lines.

Our starting point of the search720 image remains at 1:15, we see the entire image. Click on the End button at the top of the Ken Burns Effect window. Slide the Zoom bar to 2:30. Now click into the visible area and drag the clip to the left a bit to put a piece of the woman’s face in the frame as shown.

It will tell you that the Transition will need to be re-rendered, which is fine, so click on OK.

If you want you can preview the effect by clicking on the Preview button before you apply the effect. If it looks correct then click the Update button.

Every clip that has an effect put on it will need to build or render the effect before you can watch it. You can see the little red line progress across the clip as it renders. When it is done, you can play the clip in your Timeline and see the effect.

You can now add the Transition between search720, and the girl image.

Audio Editing

Digital Storytellers often want to integrate musical soundtracks into their movies. Music can make a huge difference in the impact of your movie.

In a typical digital story, the music begins and established a mood for the piece, a title slide appears, and then the narrator begins their story. In this piece, it means we need to shift all the tracks in the movie over in time to the right, in order to create a space for the music to start prior to the first narration.

To do this, we need to use the Shift Select function that is available in many software programs, including your word processor. By holding down the Shift key on your keyboard, and clicking once on all the clips in the Timeline, you can then drag all the clips to the right. We suggest you move them over about 5 seconds to allow for the music to establish the movie.
You can also move the voiceover clips in the audio tracks in using this method. If we want to see the audio wave forms, we can select **Show Audio Wave Forms** from the View Menu.

Our next step is to add the soundtrack. Go back to your audio menu and select the *guitar* clip, and drag it to the second audio track in the Timeline. If we play the movie now, it feels like the music is too loud for the voiceover.

iMovie can assist you in lowering the soundtrack volume to “mix” the audio effectively. Select **Show Clip Volume Levels** from the Edit Menu. If you click on the speaker next to the Clip box below the audio in the Timeline, you can actually now adjust the volume of the soundtrack down.

Add a button along the line, where the voiceover begins, by clicking your mouse on the line and dragging down.

Now when you listen to the movie, the soundtrack decreases in volume just as you begin to speak. If you would like, you can turn the volume up after the voiceover ends as well.

### Fade In and Fade Out Transition

Before we move on to adding our end title, let’s fade in to the first clip in the movie. Typically in movies and films, the first scene, and the change between scenes fade in from black. We can do the same in iMovie. Choose **Cross Dissolve** or **Fade In** from your Transition menu, and drop it on the left edge of the first clip as shown. We are dissolving from black to the first image.

Similarly, iMovie has a **Fade In** and **Fade out** Transition. Go to the end of the movie on the *mother* image, drag and drop in the Fade Out Transition on the right edge of the clip as shown.

### Making Titles

Creating title credits for your movies is an essential part of completing your Digital Story. iMovie offers a large number of cool titling effects to support you.

Just as we began our movie with the *moon* image, we want to return to the image at the end of the movie as the voiceover stops, and music comes back up. In your Photos
menu, select *moon720*, and then change the duration slider to 5:00. Now drag the title into the Timeline after the *mother720* image.

iMovie puts titles on top of the clip you have selected, so make sure you have the *moon720* clip selected and then choose the Title menu on menu bar.

We have two different texts we want to come up during the title sequence. The first is the name of the movie, *Momnotmom*, and the second is the author, in this case, *Thenmozhi Soundararajan*. We are going to use the **Converge to Center Multiple Title** to allow us to put the text on the screen.

We type the titles we want in the lower area. We can adjust size, and font on the texts, choose a text color, and adjust the timing of each text. Our choices were a medium size, *Arial Black Regular*, a nice teal blue color (using the color picker), and the speed at a range that allows the effect to take place while the *moon720* image is up, about 4:22 in total for the 5 seconds the clip will be up.

You can preview to view the title appearing and adjust to your own design sensibility. When you are ready, you just drag the **Converge to Center Multiple** choice down on top of the final moon image. We suggest you add a fade in and fade out transition to the beginning and end of the *moon720* clip to have the title fade in and out as well.

Congratulations, you have created a complete digital story using iMovie. What great work!

Be sure to save your work! This is a “Finish Edit” with all titles, transitions, “Ken Burns” and other effects.

---

**Exporting your Movie - Final Steps**

You are completely done, except for creating a new iMovie file. If you want to simply record your movie to tape, you would switch on your camera and go to **File, Share, To Camera**. But many times you want to make a file for multimedia, or web presentation. You can do that by choosing **Share, Quicktime**, and then select from a number of uses.

If you want to make a low quality but tiny version of the movie, you choose Email. For the web, you can choose Regular Web or Web Streaming (for Quicktime streaming off an OS X server). If you know you want to distribute it on a CD ROM, you can choose that version, or finally you can keep it as Hi-Resolution DV file for working with at a future date in other programs.
Another form of output is to DVD, and the iLife toolset allows to begin the process of taking your iMovie video to DVD directly through iMovie. Note that if you have used certain effects within the iMovie palette of effects, slow motion or reverse clips, you will want to render them before proceeding into the iDVD environment.

We will not explore the iDVD authoring environment in this tutorial, but you will find it wonderfully easy to create very professional looking DVD’s.

Congratulations, you are now ready to become a Digital Storyteller using iMovie!

On the following page is a Hands-on Workshop Guide, covering the Tutorial outlined on the previous pages. The numbers in the margins above represent each step in the Tutorial. This handout provides workshop leader and participants with an “at-a-glance” guide to the hands-on workshop activities.
Introduction to iMovie 5.0

Hands-on workshop exercise: Learning to use iMovie 5 to create a digital story

1. The script for this example comes from former CDS community programs director Thenmozhi Soundararajan who created Momnotmom, a movie about her mom, used as the basis of our tutorial.

2. In iPhoto, import all of the images from sizeimag folder from the Photoshop Tutorial project. If you already have a lot of images in your iPhoto Library, create an Album with those images.

3. In iTunes, import all of the files from the voiceover and soundtrack folders into your iTunes Library. If you have a lot of music in your iTunes Library, create a Playlist with those sound files.

4. Open iMovie and create a New Project [File Menu -> New Project] and call it “Momnotmom” and save it either in the Movies folder or on the Desktop.

5. Audio tab: Import three voiceover clips: a_theres, b_search, and c_across and place them one at a time on Timeline. Drag each clip up to the first Audio Track on the Timeline Viewer (or use the Place at Playhead button). Move cursor on timeline to the end of each clip before importing the next sound. SAVE Project [File Menu -> Save]

6. Photo tab: Turn OFF Ken Burns effect before starting. Set the Magnification to 1.00 (in Photos tab). Set the length of the image to 3 seconds. (If there are no images in iPhoto to select, drag the first image onto the timeline and change the settings.) Import and organize the images first on iMovie’s Clips tab [becomes a rough storyboard] or in an iPhoto Album:

<table>
<thead>
<tr>
<th>File Name</th>
<th>Length (seconds:frames)</th>
</tr>
</thead>
<tbody>
<tr>
<td>moon720</td>
<td>02:25</td>
</tr>
<tr>
<td>search720</td>
<td>26:00</td>
</tr>
<tr>
<td>girl720</td>
<td>03:00</td>
</tr>
<tr>
<td>young720</td>
<td>03:00</td>
</tr>
<tr>
<td>doctor720</td>
<td>03:00</td>
</tr>
</tbody>
</table>

7. Clips tab: Add a video clip: File Menu -> Import the file wife.mov inside the videos folder. It will go into the Clips pane. Crop the video to around 2 seconds and 20 frames [Edit Menu -> Crop]. Drag the clip onto the timeline.

8. Photos tab: Insert last image (mother720) at the end of the timeline.

This is a “Rough Edit” with all images and sounds on the appropriate timeline, SAVE the Project.

9. Transition tab: Select the Cross Dissolve transition and set to 10 frames (00:10). Drag to timeline between first two clips and let go. Add transitions between all edits in movie. Notice that it “borrows” time from each clip and shortens the movie.

10. Photos tab: Apply “still motion” effects (the “Ken Burns” effect)
    Select image on timeline, turn on Ken Burns effect
    Select Start and Finish magnifications and length of clip
    Preview and Apply when satisfied (rendering may take a long time). SAVE frequently!


12. Transition tab: Add Fade In and Fade Out transitions: Cross dissolve on left side of first image, Fade Out on right edge of last image.

13. Photos tab: Insert moon720 for 5:00 seconds at end of timeline

14. Titles tab: Select last image and insert title with the name of the movie and author. Use Converge to Center Multiple Title for 4:22 of total clip. Add short Fade In and Fade Out transitions.

15. Save the project. This is a “Finish Edit” with all titles, transitions, “Ken Burns” and other effects.

16. Export the project: File Menu -> Share to Email, HomePage, Video Camera, iDVD, QuickTime